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1 How to get started

The Content Management System (CMS), otherwise known as Cascade, is the only supported method
for developing official UNB websites.

To get started with the CMS you first need to submit a request to Information Technology Services for a
new website or to have an old UNB website migrated. An online request form can be found at
https://eservices.unb.ca/applications/its/projectrequest

If you already have a site within the CMS you will require the following:

* UNB Login ID and Password

* Appropriate Website Access

¢ CMS User’s Manual

* UNB Web Style Guide

* VPN (Virtual Private Network) software is required if working from off-campus. To download
the VPN software please see the ITS website (http://www.unb.ca/its) and click on the
‘Download Free Software’ button.

One of UNB'’s web presence objectives is to provide the same look and feel and send a consistent
message. To ensure this standard please download the UNB Web Style Guide, which is available on the
Web Services website, http://www.unb.ca/webops/documentation/cms-guides.html

1.1 Logging into Cascade (CMS)

To log into the Cascade Server CMS, go to https://cms.unb.ca/. The username and password are your
UNB Login ID and Password. You can also access the CMS through your myUNB portal
(http://my.unb.ca), by logging in and finding ‘CMS — Cascade’ under your ‘Quick Launch’.

Do not use the Remember Me option on a public machine.

/C(f 5/: Cascade Server

Log in to Cascade Server

Remember me

© 2014 Hannon Hill Corporation

The University of New Brunswick CMS (LIVE)

Note: If you are working off-campus, you will require the virtual private network (VPN) software to
access the CMS from outside of the UNB network. If you are a student please contact the ITS Help Desk.
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2 What’s New?

Expandable Menus

There is now the option of creating expandable menus for your website, these menus are for textual
information only. For more information please see section 7.12. Requests for expandable menus can be
made to solutions@unb.ca.

Multi-Column Pages

For the past 5 years the only option for our webpages was one main content area, we now have
additional layouts for you to choose from. The additional layouts have the option to include a side
navigation menu or proceed without one. Please review section 4.2.1 for more information on the
different page types available to you.

Biography Blocks

To provide our users with the best possible web experience we have created a responsive (mobile and
tablet friendly), accessible (for the visually-impaired) and properly aligned option for creating biography
pages. Previously many individuals were creating these in a table format, or attempting to use the
image insert tool within the content editor of the CMS, unfortunately these methods can create issues
on mobile/tablet devices, as well as issues with screen reader software.

Please review section 7.6 on the biography block for more information. If you currently have a
biography page on your site that was not created with the new biography block please consider

requesting the block to provide a better experience for your users.

You can request the block by emailing solutions@unb.ca.

Relationships tab

In the past it could be difficult in determining whether a page or file within your site was linking to any
other pages. Cascade now has a button that will determine this for you, the ‘relationships’ tab can be
found along side your ‘publish’ tab. When you select this tab, if your page is linking to another page
within your website it will display the CMS path.

This will help in removing links on other pages when you delete a page that is no longer needed.
Unfortunately when you remove a page from the CMS, it does not remove the links from other pages.
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3 Understanding the CMS and your site
3.1 The Dashboard

£ Dashboard © Learn Mon

[ET™T"0 | Messages || Workflows || Locked Assets | Drafts || Stale Content | Recycle Bin || Analytics

History # Content to Review # Messages o

[2) fredericton/business/contactus Needs Review In ne (=7 Workflow 'Assisted Workflow: CETL' is complete

[2) fredericton/business/index No assets with B Past Due (0)
&) fredericton/business/news-events Upcomning (0) Drafts o

B Scheduled (0)
fredericton/business
You have no drafts
fredericton/business/stories

Stale Content ]

webdev/alumni

Locked Assets o
webdev Last Updated 60 or more days ago

Stale (1298) You have no locked assets
New Content & B Fresh (36)

Workflows o

No Starting Page is configured for your user in this site.

No default Content Wizards are available

The dashboard is the first screen you will see every time you log in. It offers quick access to the
following areas:
Displays pages that you may have checked out. Only the person who originally
Locks locked a document or a system administrator can unlock it. You may also email
solutions@unb.ca and ask for it to be unlocked.

Drafts Saved draft copies of your content.
Recent History Provides links to the last items you accessed.
Recycle Bin Recover deleted files.

The dashboard also has the folder structure of the UNB Web Information Architecture, located on the
left hand side (much like the directory listing on a Windows machine — [e.g. Windows Explorer]).

Tip: To return to the Dashboard at any time click Home in the blue menu bar in the upper left corner of the screen.

3.2 Locating your website

3.2.1 Public Side (Sites of interest to outside UNB individuals, i.e. faculties)

As part of the setup process ITS will provide a path to your website. For example, if your site is located
at /fredericton/business then you navigate using the left-hand panel to this directory.

To locate your site, from the dropdown menu at the top of the screen, select ‘Public’.

To locate your website in the live environment, your URL would be
http://www.unb.ca/fredericton/business
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3.2.2 Internal Side (Sites of interest to the UNB community, i.e. service
departments)

As part of the setup process ITS will provide a path to your website. For example, if your site is located
at /saintjohn/iss then you navigate using the left-hand panel to this directory.

To locate your site, from the dropdown menu at the top of the screen, select ‘Internal’.

To locate your website in the live environment, your URL would be http://www.unb.ca/saintjohn/iss

3.3 Folder and Icon definitions

Web pages appear with a blue icon.

Folders appear as folder icons.

External links appear as globes.

Images and other files like PDFs appear as orange square file icons.
Blocks (additional components) appear as “lego”-type blocks/icons.

v wN e

Note: Files do not have “.htm” or “.html” file extensions. They system will add the “.html|” when the
page is published.

3.4 The (Blue) Cascade Toolbar

Cascade Server

public  » Page *Q || Standard - No Side Nav

= Base Folder

+ public 7] Message Photo Gallery »Q| | Standard - Side Nav

P T T Messages | Workflo

& External Lin k

| File

Folder Create/Manage Content

’ “2 Recycle Bin

On the Cascade toolbar you will commonly use:

(o 11 [ [ Aol Checking the status of your publish job.

1l -l Returns you to the Dashboard.
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From the public menu

(create a page from template)

P
age . (used for navigation)
External link . .
File (upload an image, document, or another type of file)
(create a folder within your site)
Folder

3.5 The elements of your site

When Information Technology Services builds your basic site, it will include several important folders:
_internal and _resources. It will also include an index page, which is the homepage for your site, which
include features such as a slideshow (or page banner), an Ad Block, a News/Events Block, and a Story
Block.

3.5.1 The _internal Folder

The _internal folder stores items that control some functions of your website. This area is for ITS use
only.

Note: The _internal folder is NOT PUBLISHABLE and you should not add files to it.

3.5.2 The _resources Folder

The _resources folder is where your images, PDFs and other downloads are stored.

It is important to keep your images, PDFs and other downloads organized in your resources folder. It is
recommended that you create additional folders to organize your files.

3.5.3 The Index page

This is the homepage for your site, which Information Technology Services will help you build. It can
contain elements such as an image slideshow, ad block, new stories and more.

2014 | Information Technology Services Page | 7



Cascade Content Management System Information Technology Services

4 Building your Side Navigation Menu

Your site’s side navigational menu is built dynamically based on the way your pages and folders are
structured. The Display Name in the file’s metadata is used to create the link in the menu, which is why
it’s important that it be entered properly.

4.1 Creating a Folder

Folders are used when you have two or more pages on one topic. For example, if you have 5 pages
relating to undergraduates place them in a folder called undergrad.

If you have a single page of information place them under the main folder. For example, a single page of
contact information would be a single page called contactus.html.

When you want to create a new folder you must first select the folder (location) you wish to place the
newly created folder into.

=  Onthe menu bar click New > Public > Folder.
= Change the System name.

= Set the Display Name.

= Click Submit to save your folder.

System Name is the name of the folder within the CMS, its also apart of your URL. Please make sure
your system name follows proper naming conventions. Lowercase, numbers, underscores and
hyphens are permitted. See Section 6.1.7.

Display Names should only be one or two words. It will show up in the side navigation of your page.
IMPORTANT: Do not change the structure (file names) of your site unless it is a critical change. Google
will not know the structure has changed immediately, which results in broken links. You also do not

know who else (inside and outside the UNB community) is linking to your pages.

New Folder

Create
System  Metadata
System Name undergrad
Parent Folder [public/webdev/usr/aurq]

Inline Metadata

Undergraduate
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4.1.1 Index Page

Every folder requires a ‘landing page’ called an index page (Page with Side Nav) to run the pages in the
folder. If you do not have an index page the breadcrumbs will break, resulting in an error 404 (your site
is broken). This page is created like any other page. See Creating Pages next section.

Note: The index page display name must match the display name of the folder.

4.2 Creating a Page

There are currently five standard page types you may use. For each page type you have the ability to
choose whether or not the side navigational menu is included.

4.2.1 Page Types

4.2.1.1 Standard — Side Nav

This is the most common page type, and the one you should use by default. Itincludes a side
navigational menu that will be dynamically built for you.

B Home < Future Students
Future Students

Discover your true potential

Welcome to the University of New Brunswick. Step

into a world where learing, tradition and inspiration
are combined into a great life experience. Step into
a world where learning is about more than just

studying
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4.2.1.2 Standard — No Side Nav

This page does not contain a side navigational bar, and allows the content to span the full width of the
page. The most common use of this page type would be for a news article.

Note: Using a no-side nav page for navigational purposes can be frustrating for people browsing the
website. It will require them to use their back button or rely on the breadcrumbs. When choosing a no-
side nav look at it from a user’s perspective to see if it makes sense.

Out of the classroom

Aaron Cao and Cathy Duan aren't quite finished their master of business
administration degrees, but they're already hard at work in the finance industry.

The students just finished working on the fourth of five modules of their one-year
concentrated MBA degrees at the University of New Brunswick Saint John campus. They
each spent 10-week work terms with the New Brunswick Securities Commission

L (NBSC), researching e-Learning tools to be deployed through the commission's website

to educate investors.

Note: You cannot change from a side nav to a no-side nav (and vice versa) without recreating the page.
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4.2.1.3 Multi-Column 1-2-1

This page type will allow your content to be divided up into four sections. One column will span the top
of the page, two columns in the middle section, and the last column will span the bottom of the page.
There are two versions of this page, no-sidenav (no navigational menu) or sidenav (includes a navigation
menu).

Future
Future Students

Canadian

Discover your true potential

International
With two main campuses, UNB is large enough to offer a wide range of programs yet small enough for the professors to actually know Law
your name. Our students receive a quality education while learning about the world, future careers and life in general.

Graduate
Welcome to the University of New Brunswick. Step into a world where learning, tradition and inspiration are combined into a great

life experience. Step into a world where learning is about more than just studying. Continuing Education

With two main campuses, UNB is large enough to offer a wide range of programs yet small enough for the professors to actually know TansierSucents

your name. Our students receive a quality education while learning about the world, future careers and life in general. Request Information
Book a Tour Online

Choose UNB Discover your true potential. Discover

About 12,000 students from more than 100 countries have U N B'

chosen UNB. We offer over 35 degree programs and 36 There are also lots of campus activities - clubs and societies,

certificate and diploma programs in 110 disciplines. As a recreational and varsity sports, student unions and a couple of

UNB student, you will be fully prepared to achieve your student newspapers. There is always something going on and

personal and career goals. Many programs (full-time and tons of people to make your university experience one of the best

part-time) offer real-life work experience to provide you times of your life!

with a balance of practical skills and academic knowledge.
Our students come from all walks of life - mature, full-time
and part-time, domestic and international students of all
ages and all backgrounds.

Learn more about UNB

Looking for more information about UNB? Why not check out our detailed program search tool. You can also check out admissions
requirements, learn more about tuition, financial aid and other money matters or check out student life at the University of New
Brunswick.
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4.2.1.4 Multi-Column 1-2

This page type will allow your content to be divided up into three sections. One column will span the
top of the page, and two columns in the middle section of the page. There are two versions of this page,
no-sidenav (no navigational menu) or sidenav (includes a navigation menu).

Future Students Future Students
Discover your true potential Canadian
With two main campuses, UNB is large enough to offer a wide range of programs yet small enough for the professors to actually know International
your name. Our students receive a quality education while learning about the world, future careers and life in general. Law
Welcome to the University of New Brunswick. Step into a world where learning, tradition and inspiration are combined into a great
Graduate

life experience. Step into a world where learning is about more than just studying.

With two main campuses, UNB is large enough to offer a wide range of programs yet small enough for the professors to actually know Continuing Education

your name. Our students receive a quality education while learning about the world, future careers and life in general. Transfer Students
. . . Request Information

Choose UNB Discover your true potential. Discover

UNB Book a Tour Online
About 12,000 students from more than 100 countries have
chosen UNB. We offer over 35 degree programs and 36 There are also lots of campus activities - clubs and societies,
certificate and diploma programs in 110 disciplines. As a recreational and varsity sports, student unions and a couple of
UNB student, you will be fully prepared to achieve your student newspapers. There is always something going on and
personal and career goals. Many programs (full-time and tons of people to make your university experience one of the best
part-time) offer real-life work experience to provide you times of your life!

with a balance of practical skills and academic knowledge.
Our students come from all walks of life - mature, full-time
and part-time, domestic and international students of all
ages and all backgrounds.

There are also lots of campus activities - clubs and
societies, recreational and varsity sports, student unions
and a couple of student newspapers. There is always
something going on and tons of people to make your
university experience one of the best times of your life!
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4.2.1.5 Multi-Column 1-3-1

Information Technology Services

This page type will allow your content to be divided up into five sections. One column will span the top
of the page, three columns in the middle section, and the last column will span the bottom of the page.
There are two versions of this page, no-sidenav (no navigational menu) or sidenav (includes a navigation

menu).

Future Students

Welcome to the University of New Brunswick. Step into a world where learning, tradition and inspiration are combined into a great

life experience. Step into a world where learning is about more than just studying.

Discover your true
potential

With two main campuses, UNB is large
enough to offer a wide range of
programs yet small enough for the

professors to actually know your name.

Our students receive a quality
education while learning about the

world, future careers and life in general.

Learn more about UNB

Looking for more information about UNB? Why not check out our detailed program search tool. You can also check out admissions
requirements, learn more about tuition, financial aid and other money matters or check out student life at the University of New

Brunswick.

Choose UNB

About 12,000 students from more than
100 countries have chosen UNB. We
offer over 35 degree programs and 36
certificate and diploma programs in 110
disciplines. As a UNB student, you will
be fully prepared to achieve your
personal and career goals. Many
programs (full-time and part-time) offer
real-life work experience to provide you
with a balance of practical skills and
academic knowledge. Our students
come from all walks of life - mature,
full-time and part-time, domestic and
international students of all ages and
all backgrounds.

2014 | Information Technology Services

Discover your true
potential. Discover
UNB

There are also lots of campus activities
- clubs and societies, recreational and
varsity sports, student unions and a
couple of student newspapers. There is
always something going on and tons of
people to make your university
experience one of the best times of your
life!

Future Students

Canadian
International

Law

Graduate
Continuing Education
Transfer Students
Request Information

Book a Tour Online
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4.2.1.6 Multi-Column 1-3

This page type will allow your content to be divided up into four sections. One column will span the top
of the page, and three columns in the middle section of the page. There are two versions of this page,
no-sidenav (no navigational menu) or sidenav (includes a navigation menu).

Future Students

Discover your true potential

With two main campuses, UNB is large enough to offer a wide range of programs yet small enough for the professors to actually know

your name. Our students receive a quality education while learning about the world, future careers and life in general.

Welcome to the University of New Brunswick. Step into a world where learning, tradition and inspiration are combined into a great

life experience. Step into a world where learning is about more than just studying.

Choose UNB

About 12,000 students from more than
100 countries have chosen UNB. We
offer over 35 degree programs and 36
certificate and diploma programs in 110
disciplines. As a UNB student, you will
be fully prepared to achieve your
personal and career goals. Many
programs (full-time and part-time) offer
real-life work experience to provide you
with a balance of practical skills and

Discover your true
potential. Discover
UNB

There are also lots of campus activities
- clubs and societies, recreational and
varsity sports, student unions and a
couple of student newspapers. There is
always something going on and tons of
people to make your university
experience one of the best times of your
life!

Learn more about UNB

Looking for more information about
UNB? Why not check out our detailed
program search tool. You can also
check out admissions requirements,
learn more about tuition, financial aid
and other money matters or check out
student life at the University of New
Brunswick.

Canadian
International

Law

Graduate

Continuing Education
Transfer Students
Request Information

Book a Tour Online

academic knowledge. Our students
come from all walks of life - mature,
full-time and part-time, domestic and
international students of all ages and
all backgrounds.

4.2.2 Creating a New Page

1. First, select the folder (location) where you want to place your new page.

2. Inthe blue menu at the top, choose New > Page or Multi-Column Pages and select the type of
page you want to create.
Cascade Server

New ¥ | History

public Page »] |_| Standard - No Side Nav

= Base Folder

4 [ | public L Message Photo Gallery »

|__| Standard - Side Nav
&) External Link

[ File

Folder Create/Manage Content

2 Recycle Bin
3. Fillin the System Name.

Note: Please see section 7.1.6 on Proper File Naming Conventions. Your file names MUST follow this
rule. Page names must be composed of all lowercase letters, and the only special characters allowed
are digits, hyphens and underscores. Dates should only be used when appropriate.
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System Name - | test-page

Parent Folder [public/webdev/usr/aurq]

4. Fill in the Metadata: Display Name, Title, Keywords and Description.

Metadata is data that is used by search engines to rank your site in the results. The fields
include:

All fields are mandatory for UNB

DI JEVE short name of the page (typically four words or Name displayed on your side
WVET W less) navigation
LIl title of the page (Do not use the same title twice) Shows in the title bar of your
Ex. ITS | Contact Us browser and used for
bookmarking purposes
GG words or phrases about the page Used by search engines, such as
Yahoo
DI AICH M description of the file — same as summary Used by search engines, such as

Google, the description
underneath a link

Inline Metadata
Display Name . Test Page
te | ITS | Test Page
vords ' UNB, ITS, Test, A Test Site, IT
' This is where you put a detailed description of the page.

Note: All pages require metadata. Not filling out the metadata fields will leave your pages out of
Google and UNB searches.

6. Include your page in the side navigation.
* Click on Metadata.
* In the Custom Metadata at the bottom of the window select “Include in Side Menu”
Note: Do not click on any of the other options — these are not part of your site’s
navigation.
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—1 Custom Metadata }—

Include in Global Nav? [Clves
Include in Side Menu? Yes

Rebase side menu? DYes
Rebase breadcrumbs? DYes

7. Click Submit.

* If your page has spelling or link errors, the spell/link checker will display. Once the
errors have been corrected click Submit (See Section 4.4 for more information).

4.2.3 Locking Pages

If you’re planning on making more than a minor edit to a page, you should lock it first. This will prevent
other users from making changes to it before you’re done, and will also prevent it from being published
out to the live web server before you're ready.

Once a page has been locked, it can only be unlocked by the user who initially locked it, or by
Information Technology Services.

1. Navigate to the page you wish to lock. Under the View > Lock, click “Check-out this asset”.

V.UM Edit | Move/Rename || Copy || Publish More [

Layout Preview Properties Lock Configurations

Actions

Check-out Check-out this asset

2. Agreen “Operation successful” message will display at the top of the page and it will reload.
You are now seeing the “Working Copy”.

|| /public/webdev/usr/aurq/tables

Vi Edit | Move/Rename More

Layout Preview Properties Lock Configurations

Viewing Current | Working Copy | Compare with Current
Outputs html

“5> Alumni | Current Students | Donors | Faculty & Staff | Future Students | International | P

UNB UNIVERSITY of NEW BRUNSWICK

EST. 178
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3. When you are happy with your changes (or wish to discard them and start over) you need to go
back to the View > Lock.

|| /public/webdev/usr/aurq/tables

V.V Edit | Move/Rename More

Layout Preview Properties

Viewing Current | Working Copy | Compare with Current

Manual Lock

M ouratest
User & au qtest

Locked On Nov 29, 2010 9:04 AM

Actions

Break Break the lock and discard changes
Commit Commit changes

Workflow Send into workflow

4. If you want to discard your changes, click “Break the lock and discard changes”. This will
remove all the changes you’ve made to the page and unlock it.

5. If you’re happy with the changes and want to save them, click “Commit changes”.

6. You will be presented with a Comments box. You should enter a sentence or two describing the
changes you made. These comments will show up under the Versions tab later, so if you need
to revert to a previous version in the future it will be easier to locate the right one if you put in
some meaningful comments.

!l Enter Comments

Comments |

Changed student's name and added a new line.

Submit _Cancel

7. Once you've submitted your changes, the page will be unlocked.
8. Publish the page after “Committing Changes”.

Note: If you need to delete a locked file please make sure that you have unlocked it first. Follow step 3
from above.
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4.3 Using the Content Editor

When you are ready to work on the content of your page click Edit.

The content editor in Cascade, used to format your page content, is much like what you would find in a
word processing application such as Microsoft Word. Many features are similar to those you are already
familiar with.

0|%. x| B 7 U | == == | Stles + Format s
Aa@@|: V- |E=E| | L= |¥2|Ea

Alignments (left, Format (select a formatting
center, right, style such as Heading 1
justify) paragraph etc.)
Copy Paste as Plain

Text

Ordered s

Insert Table Remove Formatting

Toggle Full
Screen ‘

4.3.1 Copying Text

If you want to take content from an existing site or another document, please follow these steps:

Copy the text you wish to paste into the CMS.

Open Notepad (Textedit in Mac OS X) (Start > Programs > Accessories > Notepad).

In Notepad, go to Edit > Paste. You will see your text without the formatting.

In Notepad, go to Edit > Select All to highlight the text. Go to Edit > Copy to copy it.

On the CMS editor screen, place your cursor where you want to place the text and go to Edit >
Paste.

6. This process will remove any of the unnecessary tags, styles or coding that might come with the
content.

vk wNRE

Note: If you are running Mac OS X you may have to configure your Textedit to use plain text. To do this
go to Textedit > Preferences. Under format select ‘Plain Text’ then close the window.

4.3.1.1 Copying Text - Alternative

If you are copying small amounts of text from another source (word, existing site, etc) you can use the
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plain text button in the CMS. This can ONLY be used for small amounts of text, large amounts will result
in spaces missing between words — resulting in more work for you.

1. Copy the text you would like placed into CMS.

2. Select the “Paste as Plain Text” icon. You will get a message saying you are now in paste as
plain text mode.

3. Paste the text into the editor and style as desired.

Note: Mac users will be required to delete the extraneous (a.k.a Microsoft) code that will appear after
pasting into the editor.

IMPORTANT: No text should be directly added from an outside source (this includes tables). This will
cause page/formatting errors. ALWAYS USE ONE OF THE METHODS LISTED ABOVE!

Once your content has been inserted into the CMS you then format the content much like you would a
Word document. Please see Section 4.3.2 on formatting basic page elements (also review the UNB Web
Style Guide).

4.3.2 Understanding Basic Page Elements

Please review this section on formatting your pages. The UNB Web Style Guide goes into greater detail
and should be reviewed prior to starting work on your website.

4.3.2.1 Headers and Paragraphs

All pages that have text on them are required to have a Header One at the start of the page. This is
called a page headline and should be consistent with the display name of the page.

Example: If your display name on the side nav says Contact Us, the page headline (header one) should
say Contact Us.

Headers Two and Three are used to break up large blocks of text. Pages with an extremely large
amount of text should use images to make it more visually appealing. Headers are NOT to be used to
emphasize text or links.

Headers are extremely important for accessibility purposes, those individuals with a visual disability
often use software called ‘Screen Readers’ to access the information on webpages. This software will
read the page to an individual, it uses the headers on a page to jump through sections. If there are no
headers used, the individual will be required to hear all of the information even if they are only looking
for a small piece near the end of the page.

Header Rules:
* They are not to be used to emphasize “notices” or other text.
* They should not be bolded, italized, or underlined.
* They should be short and relevant to the paragraph.
* Links should be created in paragraphs, not headers.
* Emails should not be in headers.
* Headers are not to be used in content/data styled tables. Please see Section 4.3.8.7.
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Future Students

Discover your true potential

Weicome to the University of New Brunswick. Step

into a world where learning, tradition and inspiration
are combined into a great life experience. Step into
a world where leaming Is about more than just

studying

With two main campuses, UNB Is large enough to
offer a wide range of programs yet small enough for
the professors 10 actually know your name, Our
students receive a quality education while learning

about the world, future careers and life in general

Choose UNB

About 12,000 students from more than 100 countries have chosen UNB. We offer over 35 degree programs and 36
certificate and diploma programs in 110 disciplines. As a UNB student, you will be fully prepared to achieve your I love the teaChlng
personal and career goals. Many programs (full-time and part-time) offer real-life work experience to provide you with

Example of a well formatted page.

bl ak TTATD

All links should be created within the paragraph text. When you create any type of link you should
never place the full URL on the website. The name of the organization should be the text your linking
from. For example, if you're linking to http://www.unb.ca the link would read ‘University of New
Brunswick’.

It is also important to remember never to list a person’s email address on the website. Doing so will
enable spam harvesters to grab that email and send unsolicited email to the person. The proper way to
link an email is to create a link to the phonebook record and have the text say ‘Email: John Doe’.

4.3.2.2 Alternative Text (“Alt Tags”)

Alternative Text is an important accessibility tool. All images are required to have ‘Alt Text’. This allows
content to be described to individuals with visual impairments. Tables should also have alternative text.
Please see Section 4.3.8.5 for more information.

4.3.2.3 Using/Styling Images
Please review the UNB Web Style Guide in regards to images. It can be downloaded from the
Communications & Marketing website (http://www.unb.ca/cm).

Key Points:

* Photos should be no larger than 300-320 pixels wide by 400 pixels high.

* Participants in the photos must be dressed in a way that respects UNB’s values & mission (i.e. no
undergarments showing, no low cut tops).

* No smoking or drinking is to be depicted in any image.

* Photos should be refreshed annually and not less often than bi-annually.

* Logos can only be used it consent is provided by the company. If using numerous logos on the
same page, please resize them (no other modifications are permitted) to be relatively the same
height/width.

* Always select an image style from the dropdown menu.
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If using any image with visual individuals in it you must have the model release form signed. You can
obtain a copy by going to the Communications & Marketing website (http://www.unb.ca/cm).

Please review Section 8.2 on Copyrighted Materials.

4.3.3 Adding Images and Documents
4.3.4 Sizing Images for the Web

* |tisimportant to properly size your images for the web. You can do this using either a desktop-
based program such as Photoshop or using the image editor built into the CMS.

* Allimages must be 72 dots per inch (dpi) and in the RGB color. As a general rule, images placed
in pages should be 300 to 320 pixels wide by no more than 400 pixels high. All images should be
in JPG, PNG, or GIF format.

* For more information on the sizing of various images and on image content suggestions, please
consult the UNB Style Guide and/or Communications and Marketing group (talktous@unb.ca).

4.3.4.1 How to resize your image using the Cascade image tool

1. You must follow Steps 1-5 on uploading a file (section 6.1.4) to use this method.
2. Once you have gotten to step 5, do not hit submit. You will see your image in the Edit
Image section of the screen, from here you can resize or crop as needed.

 « 0

L4 300

o3}

To Resize: type in a width and a height and click the checkmark icon. -
b. To Crop: select the area you want visible, the area that will be cropped turns grey,

and click the crop icon.
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pagebanner.jpg

W: 588 H:88

First version Submit

c. To Rotate: click on the rotate clockwise or counterclockwise icon.

d. To Flip: click on the flip horizontally or vertically icon. m
e. To Undo/Redo: click on the back or forward arrows.
3. When you are done with your image, click submit.

4.3.5 Adding an Image

Before you can use a new image on a page, you must first upload the file. See Section 6.1.4 for
instructions on uploading images. If you have already uploaded the image please see Section 4.3.5.1 on
inserting images.

4.3.5.1 Inserting Images
1. Be sure that you have already uploaded the image you wish to insert (See Section 6.1.4), and
place your cursor at the beginning of a paragraph.

2. Click the Insert/edit Image toolbar button (Tree icon). z, _I/ | > X7) 1
3. Inthe Insert/Edit Image window click the orange square Browse

button. The Please choose a File window will display for you to select [ Insert/edit image ]

the image.
4. Inthe column on the left, locate the image you want and click once on

it.
5. Click the Confirm button.

@Inte:"a\ OEx:e“na
Image \;,) = 0
Alternate Text [
Width/Height l:l xl:]

Note: When adding an image always use the internal tab.

6. Backin the Insert/Edit Image window, you need to fill in the Alternate Text box.

= |f you choose an image caption style, this text will be used for the caption below the
image.

= |tis also required for accessibility, and will allow visitors using screen-reader software to
have the image description read to them.

= Try to write something based on the overall content of the page, as well as what the
image represents (e.g. If a picture has students in front of a building, instead of putting
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"Students", try "Students gathering in front of Hazen Hall.").

Tip: When creating the ALT information: Be brief, Be clear, Be contextual.

7. Always leave the Width, Height and Decorative Image boxes blank.

8. Click the Insert button.

9. To edit an image after it has been inserted, click on the image, then click the Insert/edit Image
button.

10. To delete an image, select it and press Delete.

4.3.5.2 Styling Images
You must always use an image style when adding an image to a page. If you want a caption, use caption
right, if you do not want a caption use image right.

1. Insertyourimage.

2. Click on the image (white squares will appear around the image) and go to “Styles’” on the tool
bar.

3. Toalign and add a caption to the image select captionright.

4. To align the image without a caption select imageright.

imageright v Heading 2
contenttable EE = |F 2 }gl
plain
plaintable
imageright
captionright

rmv-img-brdr

Note: You will not see the caption in edit view.

Tip: The caption styles mentioned above will use the ALT text as the caption.

4.3.6 Adding Links

There are two types of links — Internal and External. Internal links are used for linking to
pages/documents within your own site. External links are used for linking to pages/documents outside
of your own site. Keep in mind this could include your own faculty.

Example: If Civil Engineering is creating a link from their contact us page to their students page they
would create an Internal link. If they were creating a link to their main faculty website they would
create an External link.

4.3.6.1 Internal Links
Internal links are links to any pages/files within your own site.

1. Select the text that you want to be linked (where people will click).
2. Click the Insert/Edit link button on the toolbar.
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I
i
]
]

£ %, x* | B I U aee Styles ~ Paragraph -
XD@B@| %y T 9 (@ e e=H |y |[=Ha
3. Click the blue page icon. In the Choose > Browse window, navigate to the page you want to link
to and click the Confirm button. You may also create a link to a document file (such as a PDF)
that you uploaded previously.

e
(L]

cee

[SXC)
tnk @ D
Target |Same Window ¥
Titl
--Styles-- i |
[ _msert

4. Select Same Window from the target dropdown menu.
5. The Title attribute does not need to be used on every link, but may be used for the ones that

need to provide the user with additional detail. The title attribute should provide the end user a
bit more clarification on what the link actually does. (e.g. if you had a link called “Stats” the title
attribute could be “Statistics on Student Enrollment 08-09”) Please note, this is only
supplementary information, nothing crucial should be hidden from the user.

6. Leave the Class alone.

7. Click the Insert button.

Tip: Linking to a PDF is the same process as linking to a page.

Note: Do not use the URL as a link name (or title), always use text. For example, if you were linking
to http://www.unb.ca the link name would be the University of New Brunswick.

4.3.6.2 External Links
External links are anything outside of your site or a non-UNB website.

1. Select the text you want to be linked (where people click).
2. Click on the Insert/Edit Link button and go to the External tab.

Target |Same Window ¥

s | --Styles-- ~

—

3. Inthe “Link” box, type or paste the address of the page you want to link to. Be sure to include
the “http://” at the beginning.
4. Select New Window from the target dropdown menu.
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5. Leave class alone.
6. Click Insert to create the link.

Note: Do not use the URL as a link name (or title), always use text. For example, if you were linking
to http://www.unb.ca the link name would be the University of New Brunswick.

4.3.6.3 Linking to Faculty/Staff Email Addresses

Instead of providing contact information for UNB faculty/staff directly on your site, it is better to create
a link to the appropriate entry in the UNB Phone Book. This way if the person ever changes their email
address, phone number, office location, etc then you don't need to worry about having outdated
information on your site. Linking to the phonebook also helps reduce the amount of spam a user may
receive.

1. Go to https://phonebook.unb.ca
2. Using the search form, find the record of the person you want to link to.

David Shipley

dshipley@unb.ca

Senior Web Content Developer
Communications & Marketing
451-6842

Alumni Memorial Building, 109
UNB Fredericton Campus

3. Right-click on the ¥ icon and choose "Copy Link Location" in Firefox, or "Copy Shortcut" in
Internet Explorer. This will copy the address for this record to your clipboard.

4. Create an External Link on your page in CMS (see above) and paste in the address in the Link
field. It will look something like this:
https://phonebook.unb.ca/index.cgi?dn=dW5iQ2FJZDOwYzc1Nzc3NjlkMmNINTAWZDQxZjE30TB
hM2JhN2ViMGI5YmQ4MDA4LG91PXBIb3BsZSxkYz11bmIsZGM9Y2E=

5. If you are having trouble finding the person's record in step #2, it's possible that they have
suppressed their record from public view. In this case, try searching the internal phonebook
page at https://phonebook.unb.ca/everyone. This version of the phonebook shows more
records, but requires a valid UNB Login ID and Password in order to access it.

Note: Linking to the private phonebook (https://phonebook.unb.ca/everyone) will require users to
login. If you want users outside of the UNB community to access the email DO NOT link to /everyone.

All links should point to the phonebook, please do not list the actual email addresses on the website.
The proper way to link is ‘Email: Information Technology Services’ with the wording ITS going to the
phonebook record. Placing solutions@unb.ca on the website will allow it to be harvested and spam
sent.

4.3.6.4 Linking to Student/UNB Special IDs/Non-UNB Email Addresses
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If you are linking to a student email address, you must have prior written consent from the student.
When linking to a student, you first need to determine if the address needs to be public for anyone in
the world to see, or if it should only be available to members of the UNB community.

To link a student address that should be visible to the UNB community only, visit
https://phonebook.unb.ca/everyone and follow the same steps as for creating a Faculty/Staff link.
Students are not visible through the public interface at https://phonebook.unb.ca, which is why you
must use the "everyone" version.

For all other email addresses, you must create an External Link with the Link field set to
mailto:<STUDENT/SPECIAL-EMAIL-ADDRESS> (for example, mailto:alb2c@unb.ca)

4.3.7 Anchored Links

Anchored links are used in instances where you may want to send individuals to a specific resource
within a page.

1. Toinsert an anchor, place your cursor where you want the link to go and click the Insert/edit
Anchor button.

Styles ~ Paragraph v
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2. Inthe “Anchor name” box, type a name for the anchor with no spaces (e.g., myanchor) and click
Insert.

Insert/edit anchor

Anchor name: I l

= The anchor will be represented by a little icon when viewing the page within Cascade, but it
will not appear on the live/published version of the page.

3. Tolink to the anchor, highlight the text that you want to be linked and click the Insert/edit link
button.

= Click on the External tab. In the “Link” box, type a pound sign (#) followed by the name of
your anchor, with no spaces, e.g., #myanchor.

Tip: Very few instances require Anchored Links; if your using Anchored Links chances are your page is to
long.
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4.3.8 Inserting Tables

To insert a table on a page in CMS, click where you want the table, then click the Insert a new table
button.

| Styles ~ Paragraph v
|8 =2 ed & &r@j 2 [EHo

Press enter ONCE after a paragraph before inserting your table. This will ensure there is proper spacing.

$2 %X, x| B I U 48|

£ @B @4 F-|:i=i=]

e
]

General Advanced

General properties

Cols Rovs
cellpadding 1] Cellspacing [ |
Alignment Border o ]
Width ] Height ]
Class [-- not set -- -

Table caption [

Property Description

Cols (columns) Enter in the numeric value of columns needed

Rows Enter in the numeric value of rows needed

Cellspacing Adds space, measured in pixels, between the cells.

Class Select a pre-designed table layout (see Select a table class)

Table caption Used for large tables to provide an adequate summary of the table contents.

Note: These are the only fields to fill in. The other fields are to be left blank they are controlled by the
stylesheet.

The stylesheet is a set of rules embedded in all UNB web pages that control things like font styles, sizes,
colors and spacing. It provides a common look and feel to all UNB pages.

Very Important: You should never copy/paste content directly into the CMS, this also applies to tables.
Tables should always be entered by hand. If you copy/paste a table you can encounter errors.

4.3.8.1 Select a Table Class
From the drop down Class list select one of the following table styles.

Important: You NEED to select a table class, if you don’t you will need to start over.
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==

General Advanced
General properties

Cols 3 Rows

u

Cellpadding Cellspacing

Alignment Left Border [o

width [100% Height

[ Notset-— 3
skip r
contenttable
CONtAIt
plaintable
plain
datatable
cataAlt
. caption }
image
Y = imageleft
imageright
subhead
imagecenter
captionright
captionleft
captioncenter

Table caption

(value)
4.3.8.2 contenttable
Column 1 Column 2 Column 3 Column 4
info info info info
nfo info nfo info
info info info info
v info nfo info
info info info info

Example of use: List of non-numeric information.

4.3.8.3 datatable
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Column 1 Column 2 Column 3 Column 4
info nfo info info
info nfo info info
info nfo info info
v nfo info info
info nfo info info

Example of use: Small spreadsheets. i.e. Tuition information

4.3.8.4 plaintable

Column 1 Column 2 Column 3 Column 4

info info info info
info info info info
info info info info
v info info info

info info info info

Example of use: Contact information with staff images.

Note: When using the contenttable or datatable styles you cannot use headers. You have to use the
header row (see Section 4.3.8.7).

4.3.8.5 Advanced Table Options

On the Advanced tab, please use the Summary properties when inserting a table. The Table summary
attribute should be added as an overview of the body data for screen readers / people with visual
impairments. Adding in the summary tag also assists with users receiving better search results. All the

other options should be left the way they are because the main UNB web settings will override most of
these settings.
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General Advanced

Advanced properties

Summary

Style

Language code
Background image
Frame

Rules

Language direction
Border color

Background color

-- Not set --
-- Not set --

-- Not set --

]
[

4.3.8.6 Editing Tables

To access all of the table-editing options in Cascade, left-click in a table cell, then right-click and you will

see the menu shown here:

&2 advanced.link_desc
€5 advanced.unlink_desc

_|/ Inserts a new table

7 Table tRoperties

% Delete Table properties

Forestry
Math

Statistics

Cell 4
Row L2

Column )

4.3.8.7 Adding a Header Row

Hospitality and Tourism

If the first row of your table contains column headers, you need to specify that it’s a header row in order

for it to be styled properly.

1. Left click in the first cell of your header row to place your cursor inside it.
2. Right click and choose Cell > Table cell properties.

=}
Header 1]

o

o
Header 3

4 Inserts a new table
7 Table properties
% Delete table

Cell » (=] Table cell properties

Row » [ Split merged table cells o

Column » [ Merge table cells

3. Setthe Cell type field to “Header”.
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Advanced

operties

Ceneral
General p!
Alignment Notset-- v| Celltype |Header v

| scope

Height

=

Vertical alignment [ -~ Not set Not set -~ ~
Width

Class - Not set -~

Update all cells in row_+

|__Update |

4. From the dropdown at the bottom left, choose “Update all cells in row”. Click Update.

4.3.8.8 Deleting a Row / Column

Information Technology Services

If you need to delete a table row or column, please first click into a cell on the row or column you wish

to remove.

1. Click inside one of the cells you wish to remove.

2. Right click and choose Row/Column > Delete row / Remove Column.
Cell >
Path: p x Row » _| Table row properties
Column » 5 Insert row before
2, Insert row after
wdvanced Options » =~ Delete row
46 Cut table row
@ 3 Copy table row
2 Paste table row before
24 Paste table row after
4.3.89 Column Width

Assigning a specific column width can be achieved by first selecting the column.

You have two options for controlling cell widths.

Option One — Assigning an individual cell width

Example: If you have five columns and you want each of them to be a different width.

1. Click inside the column (one cell) you wish to update the column width.
2. Right click and choose Cell > Table Cell Properties > and assign a Width (percentage)

2014 | Information Technology Services

Page | 31



Cascade Content Management System

Information Technology Services

General Advanced
General properties
Alignment v Cell Header |

il type |
Vgrtlcal -- Mot set -- V| Scope -- Not set -- WV
alignment
Width ‘ Height
Class -- Not set -- v
: Update current cell v|

| Update |

In the above example, the user is updating the header cell’s width. Please notice the two-highlighted
sections. One indicates the header row, the other area is where you assign the width of the column.

Option Two — Assign multiple cells a standard width

Example: If you have multiple columns and you want them all to be the same size.

PwnNpE

Click update.

4.3.8.10 Merging Cells

Click the first cell in the first column to your left.
Right click and choose Cell > Table Cell Properties > and assign a width (percentage).
From the drop-down menu located at bottom left, choose “Update all cells in row”.

If you need to merge cells within a table, first select the first cell in front of the cells you wish to merge..

1. Click inside the cell you wish to merge with other cells (the first cell in which you wish to merge

the others to).

2. Right click and choose Cell Properties > Merge table cells
3. Enterin either the number of columns or rows you wish to merge.
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4.4 Successfully Saving Your Pages:

After completing the content of your page (in the editor), click ‘Submit’ at the bottom of the page. As
part of completing your page it will automatically be scanned for spelling and link errors. Please read
the below sections for tips on getting the most out of these tools.

4.4.1 Spell Checker

If the spell checker finds any errors, it will present you with a screen like this:

Spell Check

Error Modify Suggestions Add Ignore
ternationaly O [ internationaly ] @ (internationally 3] O Add O 1gnore
nditor () conditons @ (conditions 2] O Add

O Kiewitt O (Hewitt  13) ® Add O 1gnore

(‘Submit ) ( Cancel )

For each error found, you have four options to resolve it.

1. Modify: You can click inside the text box under the Modify column and manually correct the
spelling. This is useful if none of the Suggestions are correct.

2. Suggestion: Choose the correct spelling from the Suggestions dropdown.

3. Add: If you are sure you have spelled the word correctly, you can click the Add button to add it
to the spell checker dictionary. Then it won’t be flagged as an error in the future.

4. Ignore: You can choose to ignore the error.

Once you’ve resolved (or ignored) all the errors, click Submit to proceed.

Note: The Spellchecker is based on U.S spelling. It is important to add correctly spelled words to your
dictionary so they do not appear again. This will help in identifying incorrectly spelled words.

Important: Please do not skip over the Spell Checker. It does not reflect well on the University to have
incorrectly spelled words on the website.

4.4.2 Link Checker

The Link Checker will run automatically following the Spell Checker and report any errors with the links
on your page. If it finds any problems it will display a screen like this:

Link Check

Broken Link Context Modify Ignore

3 @ ignore

1t www.unb.ca/brokenlink <a> with content: Test External Link O | hup:/ jwwwe.unb.ca/brokenlink ® 1gr

he server responded with http error code: 404

(‘submit) (" Cancel)

You have two options to resolve the errors — either modify the link, or ignore it.
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If the broken link is to another Cascade page or document, you can click the blue icon under the Modify
column and choose the correct file. If the link is to an external resource, click in the text box and correct
the link manually.

Sometimes the Link Checker may report a link as invalid when you know it is correct. This could happen
if the remote website is temporarily unavailable. In this case, you can just select Ignore to leave the link
as-is.

Note: Secure sites will be flagged as incorrect by the link checker. Select ignore.

Click Submit to save your changes when done.

4.4.3 Success!

Once you have gone through the Spell/Link Checker processes you will have successfully created your
page. When the page has been successfully created you will see this message:

Note: If you do not go through both processes (spell/link checker) then your page will time out and will
not save. You will have to re-create your page from scratch.

4.5 Adding an External Link

If you need to add a link in your menu to something that is not in the CMS (such as an old page on the
UNB site, or even an external site) you need to create an External Link.

1. First, select the folder where you want to place your link.

2. On the menu bar, select New/public/External Link.
Cascade Server

= || Base Folder public Page »

e public [ Message Photo Gallery »

) External Link

i=d| File

Folder

- 1T

=  Much like all the other files you create, you must give the external link a Display Name and a
System Name.
3. To add the link to your site’s side navigation:
On the Metadata screen, in the Custom Metadata section, check the “Include in Side Menu”
option.

Note: You cannot use a PDF file as an external link.

4.6 Changing the Order of your Side Navigation

By default, files get added to the menu in the order they were initially created. You can easily change
the order:

1. Click on the folder containing the files you wish to re-order.
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2. On the right under View > Contents, click on the Order column to sort the files.
3. You can then move files higher or lower by using the arrow icons under the Actions column.
You can also drag and drop into the correct order.

Cascade Server aurgtest | Quick Links =~ | My Settings | Help = | (
v Home Newy History Searct
= [ Base Foider /public/webdev/usr/aurq
= [ public
@ nternal 2| Edit | Move/Rename || Copy || Publish | Workflows | More b
@ [ _resources Contents  Gallery  Properties
@ [ difference
# [ excellence Name ~ order 2 Last Modified Last Modified By Actions
@ [ fredericton . 3
@ [ orientation [2) testing 1 Dec 3, 2009 2:23 PM & aurq TEAVEJSO
tjoh
/s s=intjohn photogallery 2 Mar 17, 2010 10:42 AM 8 aurq TAVESO
[ weScere ) tabl 3 Jul 12, 2010 9:22 AM a EAVE
tables ul 12, : 8 aur a g
# [ acuds = = A
B cds test 4 Jul 30, 2010 10:02 AM 8 aurq RAVEJSO
@ [ connect resources 5 Nov 29, 2010 9:09 AM 8 aurgtest T2AvVvESO
@ [/ govrelations internal 6 Nov 29, 2010 9:10 AM £ aurqtest EAVEJSO
@ [ international
# [ mechanical-engineering
=] retirees
@ [ security
3 [ usr
.-

@ [ _internal
@ [ _resources
@ [ photogallery
@ [ test

[2) tables

[) testing

Note: If altering the navigational structure, it is important to publish at the base folder. Example: If
you’re working in the ‘undergrad’ folder, republish the entire ‘undergrad’ folder.

4.7 Example of Side Navigation/Site Structure

= engineering
_internal Faculty of Engineering

+

4 _resources

4 [ depts Undergraduate Programs
il grad Graduate Programs

+ news

H undergrad Certificates & Diplomas

|:| certs

= Co-op and Work Experience
|| contact

|| faculty Outreach Programs

] index

3 outreach Contact Engineering

This is an example menu from the Faculty of Engineering. Each of the links in the menu comes from the
Display Name attribute in the metadata. You can see now how the System Name and Display Name are
related. A folder may have a System Name of depts but appear in the menu with its Display Name of
Departments.

Note: Not all files in the engineering folder appear on the menu. The only ones that show up have the
“Include in Side Nav” check box selected.
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When you click on a menu link that points to a folder, the menu will load the folder’s index page and
expand to show the contents.

= fredericton Faculty of Engineering
4 education Undergraduate Programs
= engineering Graduate Programs
H A nternal Certificates & Diplomas
+ _resources Co-op and Work Experience
= depts ~ Departments

Chemical Engineering

) chemical
Civil

o) civil

) Electrical and Computer
_,y ece X

- Geodesy & Geomatics
_‘ry gge Mechanical

\ | m Outreach Programs

&) mechanical IR
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5 Previewing and Publishing

5.1 Preview Your Work

Before publishing your changes to the web server, you should preview your work to make sure it looks
the way you want. Click on your page and go to View > Preview. This will show you your page as it will
appear when published. If you see any problems, you can go back and edit the page again.

INFORMATION for Alumni | Current Students | Donors | Faculty & Staff | Future Students | International | Parents O

UNB UNIVERSITY of NEW BRUNSWICK FREDERICTON & SAINT JOHN

EST. 1785

Future Students About UNB

-

M Home < About UNB < Quick Facts

About UNB
Quick Facts Quick Facts

Our History

* UNB'’s Fredericton campus, located in New Brunswick’s capital, was established in 1785; its Saint John campus,

located in New Brunswick's largest city, was established in 1964.
University Leadership
« UNB is among the oldest public universities in North America and the oldest English-language university in

Canada Mission Statement
Our Students Our History
« UNB has more than 11,400

Characteristics of a Democracy Hours of Operation

undergraduate and graduate students s
1
on its campuses. 2’) _rmm-‘
o " 4 ot

Careers at UNB
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5.2 Publish Your Work

1. Inthe column on the left, click on the file you wish to publish, and then click the Publish tab.
= |f you only have several pages to publish, please do not publish your entire folder, as
that can slow down the system.
= The only time a whole folder should be published is if everything in it is new or changed
or if you have made changes that will affect your side navigation.
= |f you do have to publish your entire site please do so during non-peak periods. (i.e. end
of day/first thing in the morning)

2. Click the Submit button.
View Edit | Move/Rename Copy More P

[] Destination

'2‘ 8 public/ntml/Test

| Options

Publish Report 'Z‘Se"("ate a publish report message

Publish Mode (®rublish Qun-publish

(" Submit ( Cancel

3. Depending on how busy the CMS system is, it may take some time before your page is actually
published. To check the status of your publish job click the Cascade symbol in the blue bar >
Publisher > Active Jobs. If there is nothing in the queue your job has been published.

Cascade Server | Global

Ov Home Newy |History Toolsy Administration ¥

#8 Search [ ualchristmasauction

! @ Publisher

(=) Publisher » Active Jobs
Scheduled Jobs

Utilities » Scheduled Jobs

Site Management
; 9 Current Job
Preferences pjramssivice

Configuration i

Servicesoutside

Name Site Who

| serviceswitnin Queued Jobs

|| teachingresearch
@ contact Name Site
] current

H graduate

4. After checking the active jobs, if your page still doesn’t publish, check your messages by clicking
on Home > Messages. This will report any publishing issues. If you do encounter an issue
you’re unable to solve, please contact solutions@unb.ca and include the error message.

Dashboard Messages (1) Workflows (0) Locks (0) Drafts (0)

] Name

(O [E4 publish of Page "public/webdev/spm/test’ completed (0 issue(s))

5. If the queue is empty, and your messages report no errors, please empty your internet cache. If
your page still does not appear, please contact solutions@unb.ca and include the error message
(and a screencap if possible).

6. Once publishing is complete, you can view your page at http://www.unb.ca/path/to/your/site where
“path/to/your/site” is the path to your site in the CMS under public. So if your site was located at
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/public/webdev/mysite/ then it would be available on the web at
http://www.unb.ca/webdev/mysite/

Tip: There could be up to a 5-minute delay before your changes take effect. If after this time your page does
not change, empty your Internet cache.

To empty your cache:

* |E-Tools > Internet Options > Delete Browsing History
*  Firefox — Tools > Clear Recent History
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6 File Management

If at all possible, try to permanently name files when you create them, so as to avoid renaming them
later. If you need to rename a folder/file follow these steps to ensure that there are no “lost”
folders/files on the web:

6.1.1 Determining the use of a File (Relationships tab)

To determine whether a file (or page) is being used, click on the Relationships tab. This will display the
CMS path of any pages that have a link to the file. If there are no relationships it means the file is no
longer being used and could potentially be removed. Follow the steps in section 6.1.6 to remove a file.

Note: Please remember it is best to remove any outdated files, all files stored in the CMS are available
through search engines (such as Google), students are able to find out files which has the potential to
cause confusion depending on the nature of the information.

6.1.2 Un-publish a File

The first step before you can rename, move, or delete a file is to un-publish. If you do not un-publish
the file it will still be accessible on the web via Google and UNB search results. This can cause you
problems if, for example, a student finds old tuition or application information.

To un-publish follow these steps:

In the column on the left, click on the file you wish to rename.

Click the Publish tab.

Under Options > Publish Mode change the “Publish Mode” from Publish to Un-publish.
Click the Submit button.

View Edit Move/Rename Copy m More |

[J] Destination

4

PwhpR

Options

(‘Submit ) ( Cancel )

Tip: The only time you do not need to un-publish a file is when you are updating the content of a page.
In this case publishing the file will over-write the existing one on the web.

6.1.3 Rename a File

If you want to rename a file:

1. Un-publish the file (See instructions above)
2. Click on the file you wish to rename.
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Click the Move/Rename tab.

In the “System Name” box, change the name.

Click the Submit button.

Re-publish the file (Publish > Publish Mode > Submit)

oukw

System Name tables

Parant Foldar [public/webdev/usr/aurq]

Start Workflow

Affected Destinations

: Moving/renaming this asset may cause it to be out of sync on the following Destinations. To avoid this problem, unpublish this asset first.

Destination | Target

(‘Submit ) (" Cancel )

6.1.4 Move a File

If you want to change a file’s location:

Un-publish the file (See instructions above)

Click on the file you wish to move.

Click the Move/Rename tab.

Click the Parent Folder‘s yellow folder icon.

In the Browse window, click on the appropriate new folder location.
Click the Submit Button.

Re-publish the file (Publish > Publish Mode > Submit)

NoukwNpe

6.1.5 Upload a File

If you would like to upload an image or a document to your website please follow these instructions.

Please place all image files in your img folder located underneath the _resources folder. Place all PDF
documents in your PDF folder located underneath the _resources folder. Both of these folders already
exist.

You may create additional folders under _resources as needed (for example, you can create a undergrad
folder to store all your Undergraduate-related PDF documents).

Note: If you want to upload a file to a certain folder (e.g. _resources/img/), you must first select the
folder you wish to upload to.

Important: If you are uploading an image with any identifiable people in it, you must get a UNB Model
Release Form signed. Copies of the form can be downloaded from the Communications & Marketing
website (http://www.unb.ca/cm).
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If you are uploading documents please DO NOT put dates in the filenames (unless appropriate). If you
upload a document called application.pdf, next year you can over-write the existing document with a
new version and all your links will automatically update themselves. Less work on your part.

Appropriate Use: Meeting Minutes, Newsletters (if keeping multiple copies for download), Agendas

2)

Cascade Server | Global v

& v Home Newy History Toolsy Administration ¥
= sciencedev

/public/webdev/usr/aurq/_resources/pdf/english

£ tuckerpark

E) usr V.UVl Edit | Move/Rename || Copy || Publish | Workflows | More [
= aurq
=] resources
= pdf ]  ~ Name Order Last Modified
= - (R
|| history-timeline.pdf A =
(] | history-timeline.pdf 1 Sep 30, 2010 12:05 PM
|E| tor.pdf e
[0 [=) tor.pdf 2 Sep 30, 2010 12:06 PM
] child
Select: All | None | With Selected: [ Select One 3)
] folder —

1. First, make sure your file is named appropriately. File names may only consist of letters
(lowercase only), digits, hyphens and underscores.

2. Select the folder where you want to place your new file.

Go to New > File.

4. In the File Upload section, click the Browse button.

Create
Content Metadata = System

| Data }

w

File Contents

(Browse...)

5. Choose the file you wish to upload and click Open.
6. Click the Submit button.
= When the upload is complete, you will see the name of the file appear in the file list on the
left and a preview (if available) on the right.
= The file will use the original filename as the System Name by default, so you don’t need to
fill it out.
= Metadata is not required for files at this time.

Note: If you receive an error message, check the filename to make sure there are NO capitals, special
characters, or spaces — this includes the extension (pdf, jpg, etc).

6.1.5.1 Updating an Existing File

If you have a new version of a current file on your website do not upload a new file, you can overwrite
the old copy on the website.

This has many benefits:
1. You do not have to update your links (this is done automatically)
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2. Old versions of a form are not left on the website for users to locate (do not have wrong copies
of an application submitted)
3. Links do not become broken on other websites that may have linked to your document.

To upload a new copy:

Browse to the file under /_resources/pdf/your-file-name.pdf
Click on the file.

Click on the Edit tab.

Click Browse and select the file from your computer.

Click Submit.

Then Re-publish the file.

oukwNE

6.1.6 Delete a File

If you want to delete a file:

Un-publish the file (See instructions above)
Click on the file you wish to delete.

Click on More > Delete

Check off “Un-publish Content”

Click Submit

v wN e

|| /public/webdev/usr/aurq/tables

A\ V| Edit | Move/Rename Copy || Publish .More[ égelete

Layout Preview Properties Lock Configurations Reference -

Outputs html Versions

% Alumni | Current Students | Donors | Faculty & Staff | Future Students | I

unB UNIVERSITY of NEW BRUN

Note: When deleting a file it will tell you (on the confirmation screen) what pages are linking to the
page being deleted. Remember to fix these links so users do not get an error message.

Also keep in mind that it will not tell you what other sites on the web are linking to that page.

6.1.7 Retrieving a File — Recycle Bin

If you have accidentally deleted a file you now have the option to retrieve it. The Recycle Bin holds up
to 30 days worth of deleted files (pages, folders, images, documents). You are only able to restore the
files you have personally deleted. In the case of multiple users working on a site you may have to
coordinate with a co-worker to have a file restored.

“ Recycle Bin - Items I have deleted in the last 30 days

Dashboard Messages Workflows Locked Assets Drafts m

] Name Deleted On Deleted By Original Location Actions
O |2 standard-sidenav Nov 25, 2010 11:15 AM & aurqtest public/webdev/usr/aurq r*
Select: All | None | With Selected: [ Select One & Displayin
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6.1.7.1  Single File Restore

1. Goto Home > Dashboard > Recycle Bin

2. Under actions click “Restore” 4 next to the page you would like to restore.
3. Click Submit

6.1.7.2 Multiple File Restore

Go to Home > Dashboard Recycle Bin
Check off which pages need to be restored
Select “Restore” from the drop-down menu
Click Submit

PwnNpE

“> Recycle Bin - Items I have deleted in the last 30 days

Dashboard || Messages | Workflows | Locked Assets || Drafts :TS7-Y:10]

Name Deleted On

T4 |==| standard-sidenav No
I] | tables No
Select: All | None | With Selected: [ Select One |44
: ~ Select One [

Note: If you have deleted a file and the folder it was housed in, you will get a message asking you to
select a new location. You cannot restore a file that does not have a location to be restored to.

Remember to re-publish the files after restoration.

6.1.8 Proper Naming Conventions

It is important to name your files properly in the CMS, this includes all folders, pages, documents, and
images.

The following is permitted when naming your files:
* Lower Case Letters
*  Numbers
* Underscores
* Hyphens

The following is NOT permitted when naming your files:
* Upper Case Letters
* Spaces
* Special Characters
* Dates (unless appropriate)

* Web file and folder names should never contain spaces. Spaces will result in broken links.
* When naming files, do not put “.htm” or “.html” at the end (“.html!” will automatically be added
when the page is published).
* Keep in mind that the file and folder names become part of the web address (URL), so try to
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keep them short and descriptive.

Good = about-us.html
Bad = about-the-department-of-information-technology-services.html

* Ifyou are uploading a file the extension (i.e .pdf) must also follow proper naming conventions.
When you create a file Windows may create it with uppercase letters in the extension.

If you attempt to create a page with an invalid name, you will receive this error message:

An error occurred during creation: You may only give this page a name that matches the following regular expression: ~([a-z0-9\-\_])+$

6.1.9 Types of Files Permitted

Due to the different types of web browsers (Firefox, IE, etc) and system types (Mac, Windows) not all file
types are permitted for upload.

The following are permitted:
* PDF (Document File)
* JPG (Image File)
* GIF (Image File)
* PNG (Image File)
* DOC (Microsoft Word File)

Note: Please be aware that not all users have converted to the newest version of Microsoft Word and
saving your document in a .docx (Microsoft Office 2010) extension may not permit some users to view
it. If you need to upload a word document (PDF is always better), it is best to click “Save As..” and select
the .doc (Microsoft Office 2008) format.

If you need to upload a file in a format not listed above, please contact solutions@unb.ca. Someone will
assist you in determining the best way to meet your requirements. Uploading unapproved files could
result in your access being suspended and the files removed pending review by Information Technology
Services.

2014 | Information Technology Services Page | 45



Cascade Content Management System Information Technology Services

7 Additional Features

7.1 \Versioning

If you need to undo changes to a file, you can use the Versioning feature. You can undo your last
change, or even go back to a previous version from days or weeks before. The last five (5) versions are
kept in the CMS. One use of Versioning would be if you wanted to temporarily make a change to a page
(perhaps to promote an event) then revert it back to its previous version when the event is over.

1. Select your page.
2. Click on the Advanced tab / Versions.

Edit | Move/Rename Copy || Publish gMore b Delete
Layout Preview Properties Lock Configurations

Outputs html

3. From the list select which version you want to go back to (the Last Modified On column will tell
you when each version was saved and by whom).

View Edit | Move/Rename Copy | Publish m

[ Path Last Modified On
4 1_] public/webdev/usr/aurg/testing Dec 3, 2009 2:23 PM
O || public/webdev/aurg/testing Dec 3, 2009 2:23 PM
‘:‘ 1_] public/webdev/aurg/testing Dec 3, 2009 2:22 PM
‘j ,;I public/webdev/aurqg/testing Dec 3, 2009 2:22 PM
Select: All | None | With Selected: [ Select One 3 )

4. You now have a number of options (not all are available on each version)

Newer: switches to the next newest version.

Older: switches to the next oldest version.

Current: switches to the current version.

Activate: activates the version being viewed and makes it the new current one.

Delete: permanently deletes the version being viewed.

Compare with Current: compares the version being viewed with the currently active one,
highlighting any changes.

Advanced P

Layout Preview Properties Lock Configurations

Viewing Viewing a Version | Newer | Older | Current | Activate | Delete | Compare with Current
Outputs html | pdf
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7.2 Adding/Editing News and Events

Depending on your requirements, there are three different types of ‘News/Events’ blocks. There is
‘News/Events’, ‘News/Events and Blog’ or ‘News/Events and location’. The process for updating all

three is the same.

News
Newsroom @
» Issues with the current ePublications &

» Alumna becomes Canadian Ambassador to

Afghanistan @

» Hospitality & Tourism program featured in

magazine @
» UNB researchers map weather in space @

» UNB student wins national scholarship for

volunteerism

Events

» Event 1
» Event2

» Event3[d

Blog

tidBITS @

Information Technology Services

» Beware of Scareware Scams

» New Wireless coming soon to UNB

» Ever thine, ever mine, Evernote @

» Keeping up to date part2 @

» Asimple way to know when meeting rooms are

available @

To add items to your News and Events block follow these steps:

1. Create your news or event article.

* News: Create a No-Sidenav page for your article (creating a news folder for your
articles would be beneficial).
* Events: Add your event to the main UNB Events Calendar by going to
https://es.unb.ca/apps/eventscalendar/post-event

2. Go to /news-events/ within your site folder

w

Click the Edit ta

b

4. Depending on your setup, you will see two or three sections or ‘blocks’. You will be working
with one called ‘News’ and one called ‘Events’. Depending on the type of notice you are adding,
you will create it under the corresponding ‘block’ (i.e. News article gets placed under ‘news’).

—‘ v Events

’ URL for the Events Feed

http://www.unb.ca/events/rss/unball.php

More Events

& =) [ Search ]

™ Events » Events

#

-
—| News Events L ti I
<‘ ¥ News I

URL for the News Feed http://blogs.unb.ca/newsroom/feed/
More News S [2) [ Search ]

¥ News » News |

Title

Internal Link @ [ [ search ]
Internal File @ (@ [ Search )

External Link

Title

Internal Link

Internal File

External Link

& 2 [ Search ]

@ [J [ Search]

5. Click the plus icon (+) to add a new News or Event item

* If you have more than one item you can change the order of the items by clicking on the
small black arrows in the upper left of each block to move that block up or down.

2014 | Information Technology Services
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* Todelete an item click the minus icon (-)

6. For each article fill out the following information:
¢ Title: This will appear as a title on your homepage. Enter something short and attention
grabbing.
* Choose between Internal Link, Internal File and External Link.
7. Click Submit when finished to save your changes and re-publish your homepage.

Note: Please use only one method for creating a link. If you specify both an Internal Link and an
External Link, only the internal link will be used.

7.3 Editing the Ad Block

Depending on the layout of your website, you will have the option of an ad block
featured in underneath your side navigation, or you can place it in your social media
carousel (if you have one). You can use this space to highlight important news, or
events, happening within your department or faculty.

The ad block can be used to promote upcoming events, to promote a downloadable
brochure or to point to a new service or feature of your site.

To request a new Ad Block graphic please email solutions@unb.ca with an outline of what you are
looking for. Please include an image and any text you would like to see on the graphic.

At this time, any ad blocks featured in the slideshow banner need to be updated by Information
Technology Services. To have this modified please email solutions@unb.ca

University of New Brunswick's
Facebook Wall

Twitter / UNB

> UNB: Are you looking for a

fun-filled summer camp for your

child? Look no further than
e @UNBSaintJohn http://t.co

/WYDLFj8umx

> Running a business can be

complicated. Let us help
Participant in one of our Ex.. °

Orientation 2013

How to update the ad block located underneath your side navigation

Once you have received your new graphic you can upload it to your site using the following steps:

1. Upload the image to your site’s _resources/img/ad folder and then publish it.
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2. To edit the ad block, navigate to /rwd/ad-block within your site folder and click the Edit tab.

{ Ad Blocks
' Ad Blocks

<‘ v Ad Blocks » Adverti |

Image Alt Text UNB Saint John - Faculty of Business | MBA

Ad Block Image @ [ [saintjohn/business/mba/_resources/img/ad/mbasj.jpg] | | 5
File Link @ [F [ Search ]
Internal Link @ ‘J [saintjohn/business/mba/why]

External Link

3. Enter the appropriate alternate text in Image Alt Text to describe your image (or what it links
to). This is used for accessibility purposes, those that are visually impaired will have this text
read to them via their screen reader.

4. Click on ‘search’ and locate the ad block graphic that you uploaded in step one.

5. Depending on what it is you wish to link to from the ad block, use ONE of the following three
fields

Internal Page: If you want to link to a page within your site click the blue icon to browse and

select the target page.
If you want to link to a document within your site (for example a PDF) click the

brown icon to browse and select the target document.
To link to something outside of the CMS enter the full URL (including http://) in

this field.

Internal File:

External Link:

6. When you are done making the desired changes, scroll to the bottom of the page and click
Submit to save them.

7. Republish the home page of your site (index) in order to see your changes on the web.

Note: You have the ability to add up to three (3) ad blocks underneath your side navigation by clicking

on the plus (+) icon.
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7.4 Changing your Homepage Slideshow

The homepage of your site contains a dynamic slideshow. Each time someone visits your page, a
random image is loaded. The maximum number of slides you can have in a slideshow is 5.

\

UNB Fredericton's Virtual Campus Tour | One of the most beautiful campuses in Canada. Take the virtual tour.

To request a new slideshow image please send a request to solutions@unb.ca outlining what you are
looking for. Please include any images, and the text that you would like to appear underneath the
image. Please keep in mind this text should be kept short, and contain your department or faculty
name. This text is required.

Note: At this point in time you are unable to edit, or create, your own slideshow images.

7.5 Changing your Pagebanner image

Each page on your site will have a page banner image at the top underneath the global navigational

| ))

UNB

FREDERICTON

#  Information Technology Services

To request a new pagebanner image please send an email to solutions@unb.ca and include any images
or text you would like included on the banner. Please indicate if your department, or faculty, is based in
Fredericton, Saint John, or is Corporate.

Note: At this point in time you are unable to edit, or create, your own slideshow images.

7.6 Editing the biography block

The biography block makes it easy to create a webpage with images and biographies of the members of
your department or group into your site. This template is responsive (mobile and tablet friendly),
accessible (for those that are visually-impaired) and has proper alignment/spacing within the content
area of your webpages.

The initial block needs to be created by ITS but moving forward can easily be updated by you. Images
can be no wider than 220px, height can be up to 330px. To request a biography block be added to your
website please email solutions@unb.ca, once created you will find it located in the RWD folder of your
website. This block will be under a workflow to ensure image sizes are within the restriction, images
larger than the restriction can cause alignment issues on the webpage.
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Board of Governors

Kathryn McCain, Chair

Senates
Appointed by Board of Governors Faculty and Staff
Kathryn McCain is the chair of the McCain Foundation and was appointed chair of UNB's board of Students

governors in 2012. She was previously vice-chair of the board and has been a member since 1998. ) )
T y RTIPPA Information Access & Privacy
She has served on a number of board including, the the

university honorary degrees committee and the nominating and review committee. Kathryn UMC - Secure Site
obtained a bachelor's degree in sociology from UNB. She received the university's Alumni Award Contact Us
of Honour for her contributions to the institution.

Human Resources
Brian Baxter, Vice-Chair Policy Repository
. . R . Anti-Spam Legislation
Appointed by Lieutenant-Governor in Council

test
Brian Baxter is chairman and CEO of Botsford Investment Inc. He has been a member of UNB's

board of governors since 2003 and has served on a number of board committees, including
finance, advancement, nominating and review, human resources, and investment. In May 2012,
Brian was appointed vice-chair of the board. Brian has a bachelor of arts degree from UNB. He is
an accredited businessman who allocates his time and skills to community organizations in his
hometown of Moncton, NB.

Bruce Balcom

Elected by Faculty Members (Fredericton)

Bruce Balcom is a professor in the department of physics and is the director of UNB's Magnetic
Resonance Imaging (MRI) Centre. He is also a Canada research chair in materials science magnetic
resonance imaging. Bruce has a bachelor of science degree from Mount Allison University and a
PhD from the University of Western Ontario. Bruce is best known for the development of the
SPRITE MRI technique, which is suited to quantitative studies of materials.

1. Upload the images to /_resources/img. It is recommended to create a new folder to house the
biography images.
2. Navigate to /RWD/biography and click edit.
= |

HE v (1/42)

Profile Image * @ [ [secretariat/_r /img/g bios/kmccain.jpg] S
Full Name * | Kathryn McCain, Chair

Title © | Appointed by Board of Covernors

Biography
Q% x| B 7 U | Styles - Paragraph -
@@ P-|EiE|=H | LEHe=H|v 2 |=[EHz

Kathryn McCain is the chair of the McCain Foundation and was appointed chair of UNB’s board of governors in 2012. She was previously vice-chair of the board and has been a member since 1998. She has
served on a number of board committees including, the advancement committee, the university honorary degrees committee and the nominating and review committee. Kathryn obtained a bachelor's degree
in sociology from UNB. She received the university's Alumni Award of Honour for her contributions to the institution.

Path: p

Building / Room location

Phone Number

Link to phonebook

3. Each biography section is a different individual, to add additional bios click the plus (+) icon, you can
also remove individuals by clicking the minus (-) icon. The following are required for each individual:
o Profile Image (click ‘search’ and locate the image under /_resources/img)
o Full Name
o Title
o Biography
You also have the option of filling out a building/room number, phone number, link to their
phonebook record, and a link to their personal website. If you are copy/pasting the biography from
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Microsoft Word, please remember to use the ‘Paste as Plain Text’ button in the CMS editor, this
will remove any bad code that could potentially cause alignment issues with your webpage.

4. You can re-order the bios by clicking on the arrows | BB v (/42) ; the number to the right of the
arrow specifies where the bio will be located within the order of individuals.

5. When you have finished editing, click Submit. You will enter the workflow screen; click Submit.
Once the block has entered the workflow process, please wait for approval from ITS, you will receive
an email from Cascade Server in your inbox. Until a workflow is approved, you will be unable to
modify the block.

6. Once you receive approval you will need to publish the webpage the biography block is attached

too. (i.e. /its/biographies.html) The block itself is not directly publishable.

7.7 Modifying your ‘Did you know?’ block

This area is to provide unique information, or facts, regarding your department or faculty. It is not to be
used for marketing purposes. If you have a need to advertise a service, event, or important piece of
information you can request an ‘ad block’.

This block appears at the bottom of your homepage. You can have up to five (5) different facts at one
particular time. Every time someone visits your homepage they will get a different fact.

Did you know?
UNB’s international students originate from more than 100 countries, contributing to
the cultural fabric of our host communities and the entire province. ’

UNB

saint John

MyUNB | InsideUNB | Contact UNB | Apply

If you do not have specific facts to your department or faculty, you will have the generic UNB
statements that are featured on http://www.unb.ca

To request a change to your ‘Did you know?’ block, please email solutions@unb.ca. At this pointin time
you are unable to edit your own ‘did you know?’ block.

7.8 Editing stories on your homepage

You can have two stories on your homepage at one time. To request graphics (or to have this feature
added to your website) please email solutions@unb.ca. Please include any images, and text, that you
would like to see featured on the graphic.

Getting your bearings at UNB Saint John Forestry without borders

Incoming and returning undergraduate students at the UNB Saint John will kick-off their Students from European and Canadian universities are learning about New Brunswick

university experience at fall orientation @ on Sept 3. forestry and through a specialized degree program (@ offered
by the University of New Brunswick.
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Once you have received your new graphic you can upload it to your site using the following steps:

1. Upload the image to your site’s _resources/img/stories folder and then publish it.
2. To edit the story block, navigate to /rwd/stories within your site folder and click the Edit tab.

«{ w Stories » Left Story

Left Story Title A star on and off the court

Left Story Image @ (@) [test1/1.jpg]

Left Image Alt Text A star on and off the court

Left Story Details
2| x. x| B I U 8¢ |

LRB@|Y% V=

= | Styles ~ Paragraph v
LH=|v2 [Ez

Christie Smith received the Rod Shoveller Memorial Award for her significant contribution to basketball and the community. non consectetur elit facilisis
a.Integer posuere erat a ante venenatis dapibus posuere velit aliquet. Curabitur blandit tempus porttitor. Cum sociis natoque penatibus et magnis dis parturient
montes, nascetur ridiculus mus.

3. Enter information for the story on the left-hand side of your page:
a. Title: Should be short and to the point
b. Image: Click ‘search’ and navigate to the graphic you uploaded to
/_resources/img/stories
c. Alt Text: This will be read to those that are visually impaired. A good description of the
image is required.
d. Left-story details: This text will appear underneath the graphic on the homepage. There
should be no headers, or lists, in this text.
4. Follow the same process (as step three above) for the right-hand side story.
5. Click ‘submit’ and re-publish your homepage for the changes to take effect.

7.9 Editing testimonials on your homepage

There are two types of testimonial layouts you can use on your homepage. One spans the full width of
the page, and the other appears underneath the side navigation. You can have up to three (3)
testimonials on your homepage. Graphics for your testimonials should be requested through
solutions@unb.ca. Please include the head shot of the individual (please be aware the model release
form should be filled out and signed).

Once you have received your new graphic you can upload it to your site using the following steps:
1. Upload the image to your site’s _resources/img/testimonials folder and then publish it.

2. To edit the testimonial block, navigate to /rwd/testimonials within your site folder and click the
edit tab.

2014 | Information Technology Services Page | 53



Cascade Content Management System

Information Technology Services

Title

Quote

Name

Image

UNB was the right choice for me.

On campus resources and activities allowed me to balance both a study life and

Elizabeth Cummings, BBA ('12)

=] [Z] [Internal:its/_resources/img/elizabeth.jpg]

v Testimonial

Ewal(23
Title
Quote
Name

Image

THIS SITE ROCKS!!

I'am so awesome

Me

@) [E]] [Internal:its/_resources/img/elizabeth.jpg]

3. Fill out the following information for each testimonial:

a. Title: this should be kept short. It appears underneath the graphic.
b. Quote: this is the statement provided by the student/alumni.
Name: full name of the individual providing the quote. It can include the degree and
year (i.e. BBA’12)
d. Image: click ‘search’ and locate the image you uploaded to _resources/img/testimonials
4. Click ‘submit’ and re-publish the homepage.

Note: to add, or remove, testimonials click the plus (+) and minus (-) icons.

7.10 Updating your social media carousel

The social media carousel allows you to add your latest Facebook, YouTube, Twitter, or Flickr posting
directly on your homepage. You also have the ability to add your latest ‘ad block’. The carousel is only
available on the homepage. You must be using at least three different components to have the
carousel featured on your homepage, and you can have up to nine (9) items at one particular time.

If you are only using one medium, please see section 7.15 on incorporating social media.

To request this feature please email solutions@unb.ca.

1. Click on /rwd/social-media-carousel and click the edit tab.
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~{ v Carousel Item
B w (1/4)
Media Type ® Twitter O Facebook O Youtube O Flickr O AdBlock
Title Twitter Feed
Media URL [ https:/ /api.twitter.com/1/statuses/user_timeline.rss?screen_name=UNB
Ad Block Image @ @ [ Search ]
Internal Link @ Dt h]

External Link

Ad Image Alt Text Ad Image Alt Text
«{ w Carousel Item |
Hw a (24)
Media Type C Twitter @ Facebook C\ Youtube C,\ Flickr C AdBlock
Title Facebook Feed
Media URL http:/ fwww.facebook.com/feeds/page.php?format=atom10&id=29485933539

Ad Block Image

Internal Link

External Link

Ad Image Alt Text Ad Image Alt Text

2. Fill out the following information per block:
* Maedia type: select appropriate media
* Title: Fill out an appropriate title such as ‘Twitter Feed’.
* If you are connecting to Facebook/Twitter/Flickr fill out:
* Media URL: place the appropriate Facebook/Twitter/Flickr feed URL in this
field. If you need assistance please email solutions@unb.ca.
* Ifyou are adding an ‘ad block’ image fill out:
* Ad block image: click ‘search’ and locate your ad block graphic (after
uploading to your _resources folder).
* Choose either: internal link or external link
* Ad image alt text: fill out a meaningful description for those that are visually
impaired and cannot view your graphic.

Note: To add a new carousel item use the plus (+) icon. To remove an old item, click the minus (-) icon.
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7.11 Updating your Hotbuttons

Hotbuttons are available on InsideUNB websites only. These are websites that target UNB faculty, staff,
and students (such as financial services and human resources). External sites are those that target
prospective students, parents, and media personnel (such as faculty websites).

W Information Technology Services

[ I'm new to UNB ] [ Forgot my Password! ] [ Find a Computer Lab ] [ Send Large Files ]
[ Setup Desktop/Laptop ] [ Get/Replace Photo ID ] [ Download Free Software ] [ Get IT Help
[ Setup Phone/Tablet ] [ Safe Computing ] [ Read IT News ] [ myUNB Portal ]

You can have no more than twelve (12) buttons on your homepage. The titles should be action-
oriented. These buttons must link to webpages (you cannot link to a PDF). Pop-out boxes (or
lightboxes) are no longer used due to accessibility reasons.

Important: Hotbuttons should not be a replication of your side navigation.

1. Click on /rwd/hotbuttons-homepage (you may also have buttons on secondary pages such as
hotbuttons-students) and click the edit tab.

‘{ Hot Buttons
*{ w Hot Button

BE v (1/12)

Ia) L
Is this a Help Button? « \J Yes (& No

Button Link text I'm new to UNB
Internal Link @ \_I [Public:academics/registrar/index] | | S
External Link http:/ /www.unb.ca/

# ¥ Hot Button

B v a (2/12)

O & n
Is this a Help Button? ~ ) Yes (& No

Button Link text Setup Desktop/Laptop
Internal Link @) ﬁ [Public:moneymatters/scholarships/index] | | S
External Link http:/ /www.unb.ca/

2. Fill out the following information for each button:
* Is this a help button? — This is a required field. It shouldn’t be used for more than one
or two buttons. The background of the button will turn yellow.
¢ Button link text — This is the text that will appear on your button. Given the limited
space it should be kept quite short.
* Internal Link/External Link — Select ‘internal’ if linking to a page within your own site,
select ‘external’ if linking to another UNB page or outside website.
3. Click ‘submit’ and publish your homepage.

Note: to add a new button, click the plus (+) icon. To remove a button, click the minus (-) button.
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7.12 Adding an Expandable Menu

Expandable menus can be used in replace of large bulleted lists with multiple layers of information.
When each header within the menu is clicked upon, it will expand to show additional information on
that topic. To have an expandable menu added to your website please email solutions@unb.ca and
outline the need for the menu. Please be aware that expandable menus are not intended to be used for
Frequently Asked Questions, if you are commonly receiving questions about your content, you may
want to consider how the information is laid out on your site. For assistance with content please
contact Communications & Marketing at talktous@unb.ca

Career and Employment Resources

There are a number of external resources to help you with your job search. The sections below will take you to a variety of online resources.
Resume and Cover Letter Websites
Recruitment Sites and Employment Agencies
Job Search Strategies Websites

Interview Websites

]

Networking Websites

» Ignite Fredericton @

» Fredericton Chamber of Commerce

» Atlantic Chamber of Commerce @
» Canadian Chamber of Commerce @

» Ten Thousand Coffees ©

Salary Information Websites
Labour Market Websites
Volunteer Websites

Career Exploration Websites

Career Specific Websites
Fredericton Student Services Expandable Menu
http://www.unb.ca/fredericton/studentservices/employment/career-exploration/finding-a-job.html

1. Navigate to the menu page and click ‘edit’.

2. Fill out the Metadata. This includes the Display Name, Title, Keywords and Description.

3. The Collapsible Content box contains the information that appears at the top of the webpage. The
Page Title is the header one on the webpage.

Collapsable Content |

Page Title * | Career and Employment Resources

Page Description

Q% x|B I U e
AB@m|% 9

= | Styles + Paragraph

LEHe=H|v 2 |=[EHa

There are a number of external resources to help you with your job search. The sections below will take you to a variety of online resources.

Path: p

4. Each Collapsible Content Section block is a new section (Header two) with its own set of expandable
menus. To create additional content areas, click the plus icon (+). This section is optional. If you
only want one content area with expandable options leave this blank and continue with Step 5.
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5. Each Collapsible Content Section >> Collapsible Item block is a new dropdown (expandable)
section, to create additional sections click the plus (+) icon, this will open up a new section. You can
re-order using the arrows located to the right of the arrows. You are required to fill out a Section
Heading (this is the title that will expand when clicked on) and the Section Content (this is the
information that will appear when the title is expanded).

—{ v Expandable Content » Section }

HE w (1/15)
Section Heading - | Resume and Cover Letter Websites

Section Content
2 |x. x| B I U a8

XK@y v E:s

® College Grad - Resumes

= | Styles ~ Format -

i | EEe 2He=H|v 2 |~[EHo

® Monster - Resumes

® Workopolis - Resumes

® College Grad - Cover Letters
® Monster - Cover Letters

® Job Star Central - Cover Letters

Path:ul » li » a

6. Click Submit when complete. You will then need to publish the page.

Collapsible

Content Departments

Alisting of the different departments

Arts

Alisting of the different majors within the Faculty of Arts.

Anthropology

English

Content
Area Business Administration

Alisting of the different majors within the Faculty of Business Administration.

Human

Expandable
Content lj .

Engineering

Alisting of the different majors within the Faculty of Engineering.

Chemical Engineering

Mechanical Engineering

7.13 Inserting Videos (YouTube)

For videos that are open to the public, they should be uploaded to our UNB YouTube Channel. For
videos that are to be seen by a restricted audience (in a portal community, in the LMS, etc) they should
be uploaded to Brightcove (to upload to Brightcove please contact CETL at cetl@unb.ca)

To have a video uploaded to the UNB YouTube channel (UNBTube) please contact Communications &
Marketing at talktous@unb.ca. They will review and upload the video to the channel, once uploaded a
link will be provided to you. Please email the link, along with the URL of the page you would like the
video featured on to solutions@unb.ca.

Page | 58 Information Technology Services | 2014



Cascade Content Management System Information Technology Services

7.14 Inserting Google Maps

To embed a Google Map into your webpage follow these steps:

1. Search for the location you would like to be displayed (http://maps.google.ca)

2. Inthe right-hand corner click on “Link”

3. Where it says “Paste HTML to embed in website” copy (CTRL-C) that code and paste (CTRL-V)
into an email to solutions@unb.ca

Note: Please include in your email the name of the page you would like the map embedded on.

7.15 Adding a Photo Gallery (Flickr)

To add a photo gallery to your site you will be required to setup a departmental Flickr account
(http://www.flickr.com). Within the account you have the ability to setup ‘Sets’ (also known as
galleries) to which you will upload your photos. A ‘set’ can then be embedded into your webpage, or
into a social media carousel and added to a particular page.

Once you have a ‘set’ created please email solutions@unb.ca and provide us with the URL of the set
along with your choice of page embed or social media carousel.

Note: All images require written model releases/consent for photos. No Exceptions.

7.15.1 UNB Wide Flickr Account

If you would like to add photos to the UNB-wide Flickr account please send Communications and
Marketing a request and include the photo disc. It will be assessed to determine the area of interest
and will be assigned either a Unit Level Flickr Account OR will be added to the UNB-Wide Flickr
Account.

Any photos submitted to Communications and Marketing for the Central UNB Flickr account may be
used by UNB for future promotional efforts.

7.16 Using Social Media on your Website

There are a couple different options for incorporating social media onto your website. If you have at
least three different social media accounts, you can also utilize the ‘Social Media Carousel’.

7.16.1 Facebook Feed

To request a Facebook feed, we require the URL of your website and the URL of your Facebook page (i.e.
http://www.facebook.com/uofnb). The feed will be featured in the content area of your home page.
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Find us on Facebook
[W Create an account or log in to see what your friends like.

University of New Brunswick

) Like 5,892

University of New Brunswick

Tell us what you did last night! We need to hear from you. Alcohol &
sex surveys coming to your UNB student email Monday. Win cool
prizes!

l'i Facebook social plugin

Example: Main homepage feed

7.16.2 Twitter Feed

To request a Twitter feed, we require the URL of your website and the URL of your Twitter page (i.e.
http://www.twitter.com/unb). The feed will be featured in the content area of your home page.

Tweets W Follow

)) UNB
UNB
Latest news: Professor Jeff Landine to
present about work satisfaction #unb
#unbnews goo.gl/VXSw0

() David Shipley
asd

Nice shout out by @NBSecuritiesCom to
@UNB TME lead @dshukla72 and UNBSJ
MBA grad Dinesh lyer:
nbsc-cvmnb.ca/nbsc/news_cont...

Example: Side navigation feed

7.17 Adding a User-Fillable Form

Send an email to solutions@unb.ca outlining all of your requirements (email address of the recipient for
the results, form fields, etc.) and where the current page is located.

7.18 Adding E-Commerce Features

Send an email to solutions@unb.ca outlining all of your requirements and where the current page is
located.
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8 NEED HELP?

If you need any advice on your content, please contact Communications & Marketing
(talktous@unb.ca).

For all other problems, please contact ITS Solutions at solutions@unb.ca. Be sure to include the URL of
your site or the path within the CMS (i.e. /fredericton/its/students) of the page you are having problems
with. Please DO NOT send the CMS URL (i.e. https://cms.unb.ca/entity/open.act...) this URL does not
help in determining the page you are having difficulties with.

If you require access, you can request it via Access Manager (through http://my.unb.ca) please include
the website to which you are requesting access.

If you require CMS training please send a request to solutions@unb.ca.

To download this guide in a coloured PDF format, please visit
http://unb.ca/webops/documentation/cms-guides.html

8.1 Frequently Asked Questions

1. How do | allow my supervisors to view a page before it goes live on the web if they don’t have
access to the CMS?

To allow individuals to view content before it goes live, uncheck “include in sidenav” from the metadata
(Edit > Metadata > Uncheck include in sidenav > Submit > Publish).

You can then provide individuals with the URL of the page (ex. http://www.unb.ca/cm/testpage.html)

Please keep in mind that this should only be done for a short period of time, eventually Google will
locate the page and it will come up in both UNB and Google searches.

2. How come | added/removed a page but my side navigation hasn’t changed?

Remember to re-publish your base folder (ex. If your working in ‘undergrad’ that would be your base)
whenever you make modifications to the sidenav.

The only time you republish a single page is when you make a content update to a page.
3. | published the page but the changes do not appear on the web?
First, check to queue to see where you are in the lineup (Cascade icon > Publisher > Active Jobs).

If there is nothing in the queue your job has been processed, if there is a queue you can see who is
ahead of you.

If the queue is empty, try emptying your internet cache by following the directions on page 34.
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Second, check your messages under Home on the blue bar. If there is a publish error it will say ‘Publish
of (1..issue(s)).

If there is a publish error please contact solutions@unb.ca.

4. Why won’t my file upload?

The first thing to check is whether there are any capitals, special characters, or spaces in the filename.
This also includes the extension (i.e. pdf).

If there is, rename the file and try again (from step one).

The next thing to check is to make sure you are uploading it into the correct directory. You can do this
by clicking on the folder name and making sure it highlights dark blue.

Lastly, make sure the file you are attempting to upload is under the size limit. The biggest file you can
upload is 10MB.

5. An individual no longer requires access to the website, what should | do?
If you have an individual who previously had access to the CMS that no longer requires it, please send an

email to solutions@unb.ca and include the name and user ID of the individual(s) and state that access
should be revoked.

It is important to keep the user list updated so that there are no unauthorized website alterations taking
place (especially student access).

6. | keep getting an error message when I’'m working with the CMS, why does that happen?

If your uploading a file, check to make sure the filename does not contain capitals, special characters or
spaces.

If your adding a folder or a page make sure your working within a folder you have access to.

If your still receiving an error, please send an email to solutions@unb.ca and include a screencap and
description of the error.

7. l deleted a file(s) but | forgot to unpublish, what do | do?

Its important to always unpublish files if your renaming, moving, or deleting. The reason for this is even
though it has been deleted from the CMS, it is still on the webserver (the web). This will allow Google to
find it and have it appear in search results.

If you have forgotten to unpublish a file please send in an email to solutions@unb.ca and let us know
what pages need to be removed and we will manually delete them from the web.

8. I'm trying to update my News/Events block but it says it’s not publishable?
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To have an event/news item to appear immediately you must publish the homepage (index). The file
you edit to insert your item is NOT publishable (you should also not create folders/pages here).

If you do not need the item to appear immediately, wait an hour and the index page will automatically
re-publish itself.

8.2 Copyrighted Materials

Placing material on a webpage follow the same rules of copyright as those that apply to photocopying or
publishing a book. Any material that you find on the Internet is subject to the ‘Terms of Use’ or
‘Copyright Notice’ generally located on the bottom of the site. If no information regarding the use of
the material is readily available it is necessary to contact the webpage administrator to ask permissions
to use any significant part of the work. The rules of copyright provide certain exceptions that permit the
use of small portions of others’ works for the purposes of research or private study, criticism or review
and new reporting. It is necessary to apply the rules of fair dealing when using others’ works whether it
is text, images or video.

For the purpose of research, private study, criticism or review, and news reporting, fair dealing does not
infringe copyright. To determine if you have “fairly” used the published works of others, you must
consider six factors:

1. Purpose: is the copying for research, private study, criticism or review, or news reporting? If “yes,”
continue with the next five factors. If “no,” the dealing is not fair.

2. Character: what is the intended use of the copy? For example, single copies are considered fairer than
multiple copies; destroying the copy after use is also considered fairer (placing material on the
internet is considered multiple copies unless access is restricted).

3. Amount: a larger volume of copying is considered less fair. However, it is important to note that in
many circumstances it is necessary to copy entire works, such as photos, if they meet the
remainder of the tests.

4. Alternatives: are there other non-copyrighted works available that would have served the same
purpose and was the copy necessary to achieve the purpose of the copy?

5. Nature: is the work published and widely available? If the work is not published, then it is more likely
to be considered fair.

6. Effect: will the copy unduly affect the market value?

If you have any questions about applying the rules of fair dealing the Canadian Copyright Act or UNB
Copyright Policy please contact UNB Libraries Copyright Officer: copyright@unb.ca. Information about
materials that may be licensed for use for UNB employees should be directed to UNB Communications
and Marketing.
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